Chapter 3 Applications: The Vector Data Model
This applications section consists of three tasks. In Task 1, you will import an interchange file to a coverage, convert the coverage to a geodatabase feature class, and convert the geodatabase feature class to a shapefile. Unlike ArcInfo 8.1, ArcView 8.1 does not have a tool for converting a coverage directly to a shapefile. Part of Task 1 is to examine the data structure of the coverage, the geodatabase feature class, and the shapefile. Task 2 lets you view the data models of TIN, regions, and dynamic segmentation in ArcCatalog. In Task 3, you will use the data models of TIN, regions, and dynamic segmentation in ArcInfo Workstation.

Task 1: The Data File Structure of Coverage, Geodatabase Feature Class, and Shapefile

What you need: land.e00, an ArcInfo interchange file

In Task 1, you will use the interchange file land.e00 to create a coverage, a geodatabase feature class, and a shapefile. You can then examine the data file structure of these three data types.

1. Start ArcCatalog, and make connection to the Chapter 3 database (i.e., the chap3 folder). Launch ArcToolbox. Double-click on Conversion Tools, Import to Coverage, and ArcView Import from Interchange File.

2. Use the browse button or the drag-and-drop method to add land.e00 as the input file. Save the Output data set as land_arc in the chap3 folder. Click OK. 

3. Land_arc now appears in the Catalog tree. (If not, select Refresh from the View menu in ArcCatalog.) Click the plus sign next to land_arc. Land_arc contains 4 feature classes: arc, label, polygon, and tic. You can preview each class. Arc shows lines that make up land_arc. Label shows label points for each polygon in land_arc. Polygon shows polygons in land_arc. And tic shows the tics or control points in land_arc. 

4. Right-click land_arc in the Catalog tree and select Properties. The Coverage Properties dialog shows the tabs of General, Projection, Tics and Extent, and Tolerances. Right-click polygon and select Properties. The Coverage Feature Class Properties dialog shows the tabs of General, Items, and Relationships.

5. Data files associated with land_arc reside in two folders in the chap3 folder: Land_arc and INFO. You can use the Windows Explorer to view these files. The Land_arc folder contains files such as arc.adf, bnd.adf, pat.adf, tic.adf, and so on. The INFO folder, which is shared by other coverages in the same database, contains files such as arc000.dat, arc0000.nit, and so on. All these files are binary files and cannot be read. 

6. This step is to create a personal geodatabase. Right-click the Chapter 3 database in the Catalog tree, point to New, and select Personal Geodatabase. New Personal Geodatabase.mdb should appear in the Catalog tree. (If the extension .mdb does not appear, do the following: select Options from the Tools menu, click the General tab, and uncheck the box next to Hide file extensions at the bottom of the Options dialog.) Change the name of the new personal geodatabase to land.mdb. 

7. Now you can add a new feature class to land.mdb. Right-click land.mdb in the Catalog tree, point to Import, and select Coverage to Geodatabase Wizard. In the first panel, enter land_arc by using the browse button or the drag-and-drop method and make sure that the box for polygon (the feature class to convert) is checked. In the second panel, opt to create a stand-alone feature class and click Next. In the third panel, accept default parameters and click Next. Click Finish to dismiss the Coverage to Geodatabase Wizard dialog. 

8. Click the plus sign next to land.mdb. Land_arc_polygon is the polygon feature class added to the geodatabase. (If land_arc_polygon does not appear, select Refresh from the View menu.) Click land_arc_polygon, and you can preview the geography and table of the feature class. 

9. Right-click land.mdb in the Catalog tree and select Properties. The Database Properties dialog shows Domains. A domain can be used to establish valid values or ranges of values for an attribute to minimize data entry errors. (You will use a domain for attribute data entry in Chapter 6.) Right-click land_arc_polygon and select Properties. The Feature Class Properties shows the tabs of General, Fields, Indexes, Subtypes, and Relationships. Subtypes allow a feature class to be subdivided into different classifications, each with a special attribute. Relationships can relate objects in a subtype to objects in another subtype.

10. You can use the Windows Explorer to find land.mdb in the chap3 folder. Land.mdb is a Microsoft Access database. Double-click land.mdb to see the contents of the database. Among the tables is land_arc_polygon.  You can view the table by double-clicking on it. The table is the same as the table you have previewed in the previous step. 

11. This step is to convert land_arc_polygon to a shapefile. Right-click land_arc_polygon, point to Export, and select Geodatabase to Shapefile. In the next dialog, make sure that land_arc_polygon is the feature class to convert and enter land.shp as the output shapefile. Click OK. Land.shp should be added to the Catalog tree. If not, select Refresh from the View menu. 

12. Right-click land.shp in the Catalog tree and select Properties. The Shapefile Properties dialog shows the tabs of General, Fields, and Index.

13. The shapefile land is associated with several other files including land.dbf and land.shx. You can use the Windows Explorer to view these files in the chap3 folder. Land.dbf is a dBASE file containing the attributes of the shapefile, and land.shx is an index file. 

Task 2: View TIN, Regions, and Dynamic Segmentation in ArcCatalog

What you need: emidatin, a TIN prepared from a digital elevation model; fire, a polygon coverage with regions subclasses; highway, a network coverage based on the dynamic segmentation model. 

Task 2 lets you view the data models of TIN, regions, and dynamic segmentation and their data structure in ArcCatalog. 

1. Make sure that ArcCatalog is connected to the Chapter 3 database. Click emidatin in the Catalog tree, and preview the TIN. You can use the Zoom In tool to view a small area of emidatin and the triangles that make up the area. 

2. Click the plus sign next to fire. Seven feature classes appear. Arc, label, polygon, and tic are separate features of the polygon coverage. Region.fire1, region.fire12, and region.fire123 are separate region layers built on the polygon coverage. You can preview each feature class. 

3. Click the plus sign next to highway. Five feature classes appear. Route.fastroute is a route built upon the arcs of highway. You can preview both arc and route.fastroute. The table of route.fastroute lists only the ID value and does not contain attribute data. 

Task 3: Work with TIN, Regions, and Dynamic Segmentation in ArcInfo Workstation

What you need: emidatin, a TIN prepared from a digital elevation model; fire, a polygon coverage with regions subclasses; and highway, a network coverage. 

Task 3 lets you work with the data models of TIN, regions, and dynamic segmentation using ArcInfo Workstation. You will examine the data structure of these data models. You will also create a route system on a network.

1.  TIN
Like a coverage, a TIN is stored as a directory in ArcInfo. Change the workspace to emidatin and list data files in the directory. You should see the edge list, node list, node/xy list, and node/z list. Change the workspace to the level above emidatin. Go to Arcplot and type the following commands:

Arcplot: display 9999

Arcplot: mapextent emidatin

Arcplot: tin emidatin

The TIN, emidatin, is displayed as a network of triangles. Triangles near the border are elongated rather than compact like those inside the border. This is caused by a lack of data points near the border. Unlike a coverage, a TIN does not have INFO files associated with it. Therefore you cannot further examine the TIN data model.

2.  Regions
The coverage fire contains areas that have been burned once, and some twice or even three times. The regions data model is ideal for working with overlapped polygons, such as overlapped polygons of past forest fires. Change the workspace to fire and list data files in the directory. Three region subclasses reside in the directory. Fire1 consists of areas burned at least once, fire12 consists of areas burned at least twice, and fire123 consists of areas burned three times. Each region subclass has a set of data files including the region-arc list (pal) and the region-polygon list (rxp). Change the workspace to the level above fire.

To display the three region subclasses, go to Arcplot and type the following commands:

Arcplot: mapextent fire

Arcplot: arcs fire   /*shows polygon boundaries of the coverage fire

Arcplot: regionshades fire fire1 3   /*shade areas burned at least once in green

Arcplot: regionshades fire fire12 4   /*shade areas burned at least twice in blue

Arcplot: regionshades fire fire123 2   /*shade areas burned three times in red

The three subclasses form nested regions on the computer monitor: fire123 is nested within fire12, and fire12 is nested within fire1. Exit ArcPlot.

Next, go to Tables and type the following commands:

Enter Command: select fire.patfire1

Enter Command: list

The list shows those areas that were burned at least once and the year of the fire.

Enter Command: select fire.patfire12

Enter Command: list

The list shows those areas that were burned at least twice and the years (under fire1 and fire2) of the fires.

Enter Command: select fire.patfire123

Enter Command: list

Finally, the display shows areas that were burned three times and the years of those fires. The DROPFEATURES command in Arc can remove region subclasses. 

3.  Dynamic Segmentation
For this part of Task 3, you will define a route system on a network first and then examine the data structure for the route system. The coverage highway shows the interstate and state highways in Idaho. To define a route system, go to ArcPlot and view the transportation network:

Arcplot: mapextent highway

Arcplot: arcs highway   /* plot the network

Arcplot: mapextent *   /* zoom in a portion of the network 

Arcplot: clear   

Arcplot: arcs highway

Arcplot: markercolor 2   /* set the node color as red

Arcplot: nodes highway

Now you can define a route system on highway by typing the following commands:

Arcplot: netcover highway fastroute   /*called the route system on highway as fastroute

Arcplot: path *   /path is the command to define a route system interactively

    Enter point 

    Enter point 

    9 to exit

/* Enter two nodes as the beginning and end nodes of the route system. Enter 9 to exit.

Arcplot: routelines highway fastroute 3   /* draw fastroute in green.

Arcplot: sectionlines highway fastroute   /* draw sections of fastroute in different colors

The display shows the relationships between arcs, sections, and the route system: Sections are based on arcs in highway, and fastroute is a collection of sections. 

To view the data structure of the route system, exit ArcPlot and change the workspace to highway at the Arc prompt. List data files in the highway directory. You should see the route (rat) and section (sec) data files for fastroute. Change the workspace to the level above highway. Go to Tables and type the following commands:

Enter Command: select highway.secfastroute

Enter Command: items

You should see items that were discussed under the dynamic segmentation data model.

Enter Command: list

The first record in the listing should have the F-MEAS value of 0 because this is the beginning point of fastroute. The T-MEAS value in the first record represents the length of the first section or arc in real-world measurement units (feet, in this case). The second record is for the second section in fastroute. Its T-MEAS value should be the sum of the lengths of the first two sections. This continues until the last record whose T-MEAS value should be the total length of the route system. The F-POS value of each record should be either 0 or 100, depending on the direction of the arc. But in either case each section should cover 100% of the arc because the route system was defined between two nodes on a network.

Enter Command: select highway.ratfastroute

Enter Command: items

You should see the items of FASTROUTE# and FASTROUTE-ID. Use the LIST command to see the item values. The DROPFEATURES command in Arc can remove the route system and its sections. 

